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1. Single High-Speed Capture 

For installation details please refer to the information found on your installation disc. 

Once you have completed the install procedure, double click on the Quintic software icon 

on the computers desktop to open the Quintic software. Click on the ‘Camera’ tab in the 

Main window and select ‘Single High-Speed Capture’. The camera window will open in 

standby mode.   

 

 

(The high-speed camera interface window in standby mode) 

To start the live camera preview click on the button, a live preview will now load, at 

full 752 x 480 resolution.  
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a. Camera Set-Up / Parameters 

To change the camera parameters click on the button or select the ‘Camera’ tab 

and the properties option from the drop down menu, this will open the properties window.   

Any settings that are changed within the properties window will be saved and reloaded 

next time the camera is opened.  

Parameters can also be saved as an Ini file so that various frame rate, and resolution 

settings can be saved for ease of use. 
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b. Camera Tab (frame rate & exposure) 

The camera tab allows the pixel clock frequency, frame rate and exposure time to be 

altered.   

Firstly check the ‘Optimum’ selection box, this will allow the software to run at the 

optimal highest Pixel Clock Rate. This will improve/increase the maximum frame rate at 

which the camera can capture at. 

 

Timing 

Camera Peak Bandwidth is the maximum required bandwidth in MB/sec (Peak). If the 

bandwidth is exceeded this is displayed in red.  

Camera Average Bandwidth is the average bandwidth required in MB/sec. If the 

bandwidth is exceeded this is displayed in red.  

N.B. Make sure that these values don’t exceed the bandwidth, otherwise performance will 

be impaired.  
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Pixel Clock 

Sets the clock rate at which the image data is read from the sensor. Altering this setting 

affects frame rate and exposure time. 

Frame Rate 

Depending on your bandwidth value there are varying maximum amounts of frames per 

second that can be captured. This value will decrease as the resolution value increases. 

When setting the frame rate in freerun mode the camera will capture one image after 

another at the set frame rate.   

Hold: When this check box is selected the frame rate will remain at the set rate, if the pixel 

clock changes.  

Max: when this box is selected the camera will record at the maximum rate that is possible, 

frame rate depends on the capture resolution and the Pixel clock.  

Auto: This option selects the Auto Frame Rate Function, this is only available when Auto 

Exposure is selected.  

Frame rate will increase when the user sets a new area of interest (AOI) of image (see page 

84).  

Utilising the highest frame rate possible is especially important when capturing fast 

movements e.g. the golf swing. A typical golf swing can occur at 100mph or 150ft/sec if 

your camera is sampling at 30Hz the club will move 5 feet per 1/30 of a second.   

In order to ensure that all actions are accounted for you must sample fast otherwise the 

subtle movements will be lost.  
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Example Resolution and Frame Rates: 

 

Exposure Time 

This is the amount of time the shutter remains open to allow light into the sensor in order 

to form an image.  

This option sets the exposure time. The available exposure time depends on the pixel clock 

setting and the frame rate. A low frame rate setting allows long exposure times, where as a 

high frame rate reduces the maximum possible exposure time.  

Hold: When the check box is selected the exposure will remain at the desired setting if the 

frame rate changes.  

Max: The camera runs at the maximum exposure time that is possible at the current frame 

rate.  

Auto: this option selects the Auto Exposure Function, the exposure time changes 

automatically depending on the selected frame rate.  
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See the table below which illustrates exposure time and shutter speed settings. 

 

c. Image Tab (gain boost) 

In digital imaging a voltage proportional to the amount of incident light is output at the 

sensor. To increase image brightness and contrast, this signal can be amplified by an 

analogue gain and offset before the digitising process.  

Analogue amplification of the read-out pixel values increases overall image brightness and 

contrast allowing for a height exposure value/shutter speed to be applied.  
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Click on the ‘Gain Boost’ option within the Image tab, to automatically increase the 

brightness and contrast of the image. 
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d. Size Tab (video size, area of interest) 

On this tab the user can set the image size parameters for your uEye camera. 

 

AOI 

These parameters allow the user to select the size and position of the Area of Interest 

(AOI) AOI sets the camera so that only data included within the specific area is captured. 

The smaller image enables the camera to work at a higher frame rate.  

Selecting the ‘Show Only AOI’ box sets the camera preview to only display the AOI, 

without a black border. This function saves memory and processing time when rendering 

the image.  

Width/Height 

Sets the AOI width and height.  
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Left 

Sets the left hand position of the AOI.  

Selecting the ‘Centre’ box centres the AOI horizontally.  

Top 

Sets the top position of the AOI.   

Selecting the ‘Centre’ box centres the AOI vertically. 

Mirror Left/right / Up/Down 

Select this check box to flip the image in the vertical or horizontal plane.  

Binning 

Binning allows the user to reduce the image resolution by the selected factor.  

Using the binning factor will also increase maximum frame rate. 

e. Using the Camera 

To start capturing video footage click on the            button or select the ‘File’ tab from the 

menu bar and then select record a video sequence from the drop down menu. Once selected 

the Record dialog window will open. 

 

Before recording a video click on the ‘Create’ button, this will load the ‘Save As’ 

window, select the file directory where you wish to save your video and also select a file 

name and then select ‘Save’  
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To start capturing video footage click on the ‘Record’ button, the software will now 

capture video until the ‘Stop’ button is selected or the video reaches the maximum frames 

(if selected) or the maximal size (MB).  To play the video within the Quintic software the 

capture window must first be closed. To close the capture window after the video has been 

captured click on the ‘Exit’ button.  
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f. Other Functions 

Area of Interest 

The area of interest function allows the user to centre the camera on the action they wish to 

film by altering the resolution the camera captures at. Using the AOI function also enables 

the camera to capture at a higher frame rate.  

To use AOI click on the ‘Camera’ tab and select ‘Set New AOI’ or click on the            

button.  

Once the Set New AOI tool has been selected click on the video and hold the left mouse 

button down, now drag a window over the area of interest on the screen, a white grid will 

appear illustrating your desired AOI. Once the grid is highlighting the desired AOI, release 

the mouse button, the preview screen will now only show the desired AOI and the frame 

rate will increase (only if set on max within camera parameters).  

If you wish to reset the AOI select click on the ‘Camera’ tab and select ‘Clear AOI’ or 

click on the Clear AOI button on the too   l   ba 
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To use the AOI function select ‘Set New 

AOI’ from the camera tab or click on the 

‘Set New AOI’ button on the toolbar.  

The original preview is 752 x 480 

resolution and capturing at a max frame 

rate of 87fps. 

 

 

To set the area of interest click and hold  

the left mouse button down, and drag  

over the desired area you wish to set  

as the AOI. A white grid will illustrate  

the selected area. 

 

 

 

Only the AOI is now shown on the 

preview screen and will be captured.  

The new video resolution is 468 x 234 

and the maximum recording speed is now 

205fps. 

 

 

 

 

 



15  Tutorial 5c - High-Speed Video Capture 

 

 

Image Preview Controls 

The user can control the size of the video preview screen by clicking on the ‘View’ tab and 

selecting render or by using the display function buttons located on the menu. 

 

Disable the video preview 

To disable the camera preview click on the           button this will disable the preview 

screen.  

Enable full screen video preview 

To enable a full screen preview click on the           button, to exit out of full screen mode 

click on the ‘Esc’ button.  

N.B. in order to use this function Direct X 3D may need to be installed.  

Scale the video preview to the window size. 

To fit the preview video to the open window click on the           button this will scale the 

open video preview to the current window size. 

Scaling the display 

The preview display can be scaled down to ¼ of the original size or up to twice the original 

display size.   

 Displays the video preview at original size                                            

 Scales the video preview to half size  

  Scales the video preview to quarter size  

 Scales the video preview to double size  
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Drawing tools 

When using the preview screen drawing tools can be used to highlight key areas on the 

screen although these shapes and lines won’t be saved to the video. Draw any of the shapes 

by clicking on the shape button you require, moving the cursor over the screen to where 

you want the shape to be, then holding down the left mouse button and dragging the shape 

across the screen. To add text to the video preview screen, click on the area of the screen 

where you want the text to appear and use the keyboard to type the desired text. 

 

Screenshot 

When using the preview screen a screenshot can be captured and imported into another 

program. To import a screenshot click on the           button, this will save a copy of the 

frame to the internal memory. To import the screenshot into another program click on the 

paste function or press the Ctrl button + the ‘V’ button.  

Display Rate. 

The video frame rate can be limited to 30fps. To set the display rate to 30fps click on the         

 button. 

Standby / close camera 

To close or set the camera on to standby mode click on the  button. 
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6. Multi High-Speed Capture 

For installation details please refer to the information found on your installation disc. 

From the ‘Camera’ tab select ‘Multi High-Speed Capture’. 

 

Depending on the number of cameras present, you will see that number in the screen 

below. 

If however, you have a blank screen, you will need to ensure you have followed the 

installation steps correctly: Please check Camera ID numbers with the IDS Camera 

Manager. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

N.B. The maximum recording time for one file is 5 minutes. 

It is possible to pause and continue, or 

stop recording.  

 

Select the destination folder you wish to save the video files, enter a file 

name, and start recording. 

  

 

It is possible to change the Camera exposure 

time using the slider bar should you require. 
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4. High-Speed Basler Camera Capture (XP only) 

a. Set-up 

To use high speed Basler capture the following hardware items are needed: 

        

Basler Monochrome camera. 

 

 

 

      6pin to 6pin firewire card 

 

 

PCMCIA Firewire card with an external power 

adaptor, to run high speed capture on a laptop. 

 

Before high-speed capture can be run the camera and high-speed drivers must be installed.  
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Please follow the step by step instructions below these can also be located in the following 

directory on the High speed capture installation disc that has been supplied.  

i) Make sure the Basler camera is NOT connected.  

ii) Double click on the' BCAM 1394 Runtime 1_8_0050' driver package. (Located 

on High speed capture installation disc)  

iii) Follow the instructions from the driver package and connect the camera when 

asked to do so.  

iv) Basler have produced a BCAM Viewer which can be used to test their driver and 

setup the controls for use with the Quintic-Basler Capture program. 

v) The 'BCAM Viewer' icon should have been installed on the desktop. Double 

click on this icon and check that the A602f (Basler Driver) has been installed. 

(Left Click on the A602f' driver icon located in the left hand menu. Now click 

on the 'Continuous Grab’ icon . This can be found just below the ‘Tools’ 

menu. If the driver has been installed correctly a video preview should appear on 

the right hand side. If a Preview does not appear please check all connections 

and repeat steps 1-4.  

vi) The Quintic-Basler capture program can now be loaded.  

Once you have completed the install procedure open Quintic Biomechanics and click on 

the ‘Camera’ tab in the Main window and then click on ‘High-Speed Camera Capture’. 

 

The high-speed camera window will then open. 
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The capture of AVI (Audio Video Interleave) video files requires significant computer 

resources. It is recommended that sets of pre-allocated files are created during an initial set 

up process. All video capture (AVI) are then written to these files. This approach will 

significantly reduce the risk of dropped frames during the video capture process.  

 Please click on ‘Setup’ followed by ‘Check the Current Pre-Allocation File Status’ and 

follow the on screen instructions. For more information see Tutorial 5 - Video Capture Set-

up. 

b. Capturing High Speed Video 

Double click on the Quintic Biomechanics icon on the computers desktop to open the 

Biomechanics software. Click on the ‘Camera’ tab in the Main window and select ‘High 

Speed Capture’.  The camera window will open and a live preview will appear in the right 

hand side of the capture screen.  

By clicking on the  button and then selecting the ‘Controls’ tab the user 

can alter the cameras shutter speed depending on the light. Using the 2 scroll bars can also 

alter video brightness and contrast accordingly. To reset the brightness or contrast to their 

default settings click on the ‘Reset Controls’ button. 
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Once the shutter speed, brightness and contrast settings have been altered click on the 

 button to commence high speed capture. Once you click on this button the 

preview window will disappear so make sure that the camera is set up correctly.  
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Once you have done this you will be prompted to ‘Start the Capture’. Click on the ‘OK’ 

button and the computer will begin to capture for a maximum duration of 60 seconds, if 

you wish to stop the capture process before the time limit is reached click on the ‘Stop 

Capture’ button. You will then be given the option to play the captured recording. 

If high speed capture is stopped before 

the 30-second limit. The captured video 

can be played in the preview window by 

clicking on ‘Yes’  

Once the 30-second limit is reached. 

Capture automatically stops and the 

captured video can be viewed in the 

preview window, by clicking on ‘Yes’. 

 

Use the buttons on the left hand side of the screen to play and review the captured video. 

You can also use these buttons to trim the captured videos before saving.  
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After the videos have been trimmed click on the ‘Compression Settings’ button to change 

the compression and video quality settings (See Tutorial 5 for more details).   

N.B. Once the compression settings have been set the software will remember the last 

values used during the video capture process.  

Filters can also be added to the captured video please see Tutorial 5c for more details.  

Once you have changed the compression settings, trimmed your video and added any filters 

you can save the captured video by clicking on the ‘Save Video’ button.   

 


